Selection of Pipe Materials and Incorporation Into Plan Set
To Be Covered

- Alternative Pipe Policy
- Pipe Materials
- Situation to Use Specific Pipe
- Wall Thickness
- Money Matters
- Clear Zones
- End Sections
- Incorporating Pipes Into Plans
Policy Statement:
The North Dakota Department of Transportation will allow all available pipe products (materials) that are judged to be of satisfactory quality and equally acceptable on the basis of engineering, economic analysis, and NDDOT experience.

Pipe Materials

- Concrete Pipe
  - Classes
    - Cement and aggregate contents determine the differences between the classes.
<table>
<thead>
<tr>
<th>Pipe Size (inches)</th>
<th>Class I</th>
<th>Class II</th>
<th>Class III</th>
<th>Class IV</th>
<th>Class IV Alternate</th>
<th>Class V</th>
<th>Class V Alternate</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>1-16</td>
<td>16-24</td>
<td>24-35</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>1-16</td>
<td>16-24</td>
<td>24-35</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>1-16</td>
<td>16-24</td>
<td>24-35</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>1-16</td>
<td>16-24</td>
<td>24-35</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>1-16</td>
<td>16-24</td>
<td>24-35</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>3-11</td>
<td>1-3, 11-16</td>
<td>16-24</td>
<td>24-35</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>3-11</td>
<td>1-3, 11-16</td>
<td>16-24</td>
<td>24-35</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>3-11</td>
<td>1-3, 11-16</td>
<td>16-24</td>
<td>24-35</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>36</td>
<td>3-11</td>
<td>1-3, 11-16</td>
<td>16-24</td>
<td>24-35</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>42</td>
<td>3-11</td>
<td>1-3, 11-16</td>
<td>16-24</td>
<td>24-35</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>48</td>
<td>3-11</td>
<td>1-3, 11-16</td>
<td>16-24</td>
<td>24-35</td>
<td></td>
<td></td>
<td>24-35</td>
</tr>
<tr>
<td>54</td>
<td>3-11</td>
<td>1-3, 11-16</td>
<td>16-24</td>
<td>24-35</td>
<td></td>
<td></td>
<td>24-35</td>
</tr>
<tr>
<td>60</td>
<td>6-9</td>
<td>3-11</td>
<td>1-3, 11-16</td>
<td>16-24</td>
<td>16-24</td>
<td>24-35</td>
<td>24-35</td>
</tr>
<tr>
<td>66</td>
<td>6-9</td>
<td>3-11</td>
<td>1-3, 11-16</td>
<td>16-24</td>
<td>16-24</td>
<td>24-35</td>
<td>24-35</td>
</tr>
<tr>
<td>72</td>
<td>6-9</td>
<td>3-11</td>
<td>1-3, 11-16</td>
<td>16-24</td>
<td>16-24</td>
<td>24-35</td>
<td>24-35</td>
</tr>
<tr>
<td>78</td>
<td>6-9</td>
<td>3-11</td>
<td>1-3, 11-16</td>
<td>16-24</td>
<td>16-24</td>
<td>24-35</td>
<td>24-35</td>
</tr>
<tr>
<td>84</td>
<td>6-9</td>
<td>3-11</td>
<td>1-3, 11-16</td>
<td>16-24</td>
<td>16-24</td>
<td>24-35</td>
<td>24-35</td>
</tr>
<tr>
<td>90</td>
<td>6-9</td>
<td>3-11</td>
<td>1-3, 11-16</td>
<td>16-24</td>
<td>16-24</td>
<td>24-35</td>
<td>24-35</td>
</tr>
<tr>
<td>96</td>
<td>6-9</td>
<td>3-11</td>
<td>1-3, 11-16</td>
<td>16-24</td>
<td>16-24</td>
<td>24-35</td>
<td>24-35</td>
</tr>
<tr>
<td>102</td>
<td>6-9</td>
<td>3-11</td>
<td>1-3, 11-16</td>
<td>16-24</td>
<td>16-24</td>
<td>24-35</td>
<td>24-35</td>
</tr>
<tr>
<td>108</td>
<td>6-9</td>
<td>3-11</td>
<td>1-3, 11-16</td>
<td>16-24</td>
<td>16-24</td>
<td>24-35</td>
<td>24-35</td>
</tr>
</tbody>
</table>
Pipe Materials

- Metal Pipe
  - Corrugated Steel
    - Aluminum or Zinc coated
  - Polymeric Coated Steel
    - Over Zinc or Aluminum Coated Steel
  - Structural Steel Plate
  - Aluminum Alloy Pipe
Pipe Materials

- Why is Aluminum or Zinc Used?
  - Corrosion Resistant
  - Become more resistant after initial oxide forms
  - Self-renewing film

Corrosion-doctors.org
Pipe Materials

- Plastic Pipe
  - High-Density Polyethylene
    - Softer, bendable plastic
    - Best suited for
      - Lower pressure
      - Tight Bending Radius
  - Polyvinyl Chloride
    - Stronger, Stiffer
What Pipe to Use?

- **Mainline Drainage**
  - Metal
  - Concrete

- **Approach Drainage**
  - Metal
  - Concrete
  - Plastic

- **Pipe Extensions**
  - Mainline-Match Existing Material
  - Approach-Unlike Material Acceptable

- **Storm Drains**
  - Metal
  - Concrete
  - Plastic

**Plastic Pipe cannot be used under paved roadways.**

--Plastic hasn’t proven itself yet, was a decision by management
## Abrasion

- **Level 1**: No Bedload
- **Level 2**: Sand, Gravel, Debris at Velocities of 0-5ft/s
- **Level 3**: Sand, Gravel, Debris at Velocities of 5-10ft/s
- **Level 4**: Sand, Gravel, Debris at Velocities of 10-15ft/s
- **Level 5**: Sand, Gravel, Debris at Velocities of >15ft/s

### Factors

<table>
<thead>
<tr>
<th>Approach Drainage</th>
<th>Level 1</th>
<th>Level 2</th>
<th>Level 3</th>
<th>Level 4</th>
<th>Level 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concrete Pipe (Section 830.01)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Metal Pipe (Section 830.02)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zinc Coated Corrugated Steel</td>
<td>Y</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Aluminum Coated Corrugated Steel</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Polymeric Coated Steel</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>Structural Steel Plate Pipe (Zinc Coated)</td>
<td></td>
<td>Y</td>
<td>Y</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Aluminum Alloy Pipe</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plastic Pipe (Section 830.03)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>High-Density Polyethylene (HDPE)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
</tbody>
</table>

Resistivity

- High resistivity = Low Corrosion
- Resistivity is reduced as water content and concentration of ionic compounds is increased

How it happens

- Electrical current removes metallic ions from one part of the metal and relocates them to another portion of the metal.
- Can also happen in concrete, but much less common
Corrosion

## Corrosion Zone

### Mainline Drainage

<table>
<thead>
<tr>
<th></th>
<th>Zone 1</th>
<th>Zone 2</th>
<th>Zone 3</th>
<th>Zone 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concrete Pipe</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Metal Pipe</td>
<td>Gauge</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zinc Coated Corrugated Steel</td>
<td>16 ga.</td>
<td>14 ga.</td>
<td>12 ga.</td>
<td>10 ga. Y</td>
</tr>
<tr>
<td></td>
<td>8 ga. Y</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Aluminum Coated Corrugated Steel</td>
<td>16 ga.</td>
<td>14 ga.</td>
<td>12 ga.</td>
<td>10 ga. Y</td>
</tr>
<tr>
<td></td>
<td>8 ga. Y</td>
<td>8 ga. Y</td>
<td>8 ga. Y</td>
<td>8 ga. Y</td>
</tr>
</tbody>
</table>

## Flammability

> Burning is Expected in the Area

<table>
<thead>
<tr>
<th>Concrete Pipe (Section 830.01)</th>
<th>Mainline Drainage</th>
<th>Approach Drainage</th>
<th>Storm Drain Trunk Line And Lateral Drainage</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
</tbody>
</table>

### Metal Pipe (Section 830.02)

- Zinc Coated Corrugated Steel: Y Y Y
- Aluminum Coated Corrugated Steel: Y Y Y
- Polymeric Coated Steel: N(1) N(1) N(1)
- Structural Steel Plate Pipe: Y Y Y
- Aluminum Alloy Pipe: Y Y Y

### Plastic Pipe (Section 830.03)

- Polyvinyl Chloride (PVC): N/A(2) N/A(3) N(1)
- High-Density Polyethylene (HDPE): N/A(2) N(1) N(1)

---

(1) - N; plastic coated metal or plastic pipe may not be used in flammable applications without the addition of non-flammable segments and/or end treatment as determined by the Designer.
(2) - N/A; pipe not allowed for Mainline Drainage applications.
(3) - N/A; pipe not allowed for Approach Drainage applications.
### Conversion of Gage to Thickness in Inches

<table>
<thead>
<tr>
<th>Gage No.</th>
<th>Uncoated Thickness (in.)</th>
<th>Galvanized Thickness (in.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>0.1644</td>
<td>0.168</td>
</tr>
<tr>
<td>7</td>
<td>0.1838</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>0.2145</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0.2451</td>
<td></td>
</tr>
<tr>
<td>1 1/2</td>
<td>0.2758</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>0.3125</td>
<td></td>
</tr>
<tr>
<td>5/8</td>
<td>0.375</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Gage No.</th>
<th>Uncoated Thickness (in.)</th>
<th>Galvanized Thickness (in.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>0.0598</td>
<td>0.064</td>
</tr>
<tr>
<td>14</td>
<td>0.0747</td>
<td>0.079</td>
</tr>
<tr>
<td>12</td>
<td>0.1046</td>
<td>0.109</td>
</tr>
<tr>
<td>10</td>
<td>0.1345</td>
<td>0.138</td>
</tr>
</tbody>
</table>

**Wall Thickness**

- **Conversion of Gage to Thickness in Inches**

**Gage No.**

<table>
<thead>
<tr>
<th>Uncoated Thickness (in.)</th>
<th>16</th>
<th>14</th>
<th>12</th>
<th>10</th>
</tr>
</thead>
<tbody>
<tr>
<td>22</td>
<td>0.0299</td>
<td>0.0359</td>
<td>0.0478</td>
<td>0.0598</td>
</tr>
<tr>
<td>20</td>
<td>0.034</td>
<td>0.04</td>
<td>0.052</td>
<td>0.064</td>
</tr>
<tr>
<td>18</td>
<td>0.0478</td>
<td>0.052</td>
<td>0.064</td>
<td>0.079</td>
</tr>
<tr>
<td>16</td>
<td>0.0747</td>
<td>0.079</td>
<td>0.109</td>
<td>0.138</td>
</tr>
<tr>
<td>14</td>
<td>0.1046</td>
<td>0.109</td>
<td>0.138</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>0.1345</td>
<td>0.138</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>0.168</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Money Matters

- Pay Items
  - Pipe
  - Reinforcement Fabric
  - Surfacing Removal
Money Matters

- Included In Pipe Pay Item
  - Pipe
  - Trench Excavation
  - Disposal of unsuitable excavated material and placement of suitable material on inslope
  - Aggregate Base Course
  - Approved Backfill
Additional Facts

- Pipe Conduit measured in linear feet from one edge to the other.
  - From opening to opening measured along the top
- Backfill Standard Drawings
  - 4 Feet or Less
  - Over 4 Feet
Keep in Mind

- **Hydraulics Study**
  - Needed for most pipes
  - NDDOT Bridge Division

- **Clear Zones**
Clear Zones

- Area, starting at the edge of traveled way
- Allows a driver to stop safely or for the driver to regain control of the vehicle
- Information can be found in the Roadside Design Guide
  - American Association of State Highway and Transportation Officials (AASHTO)
End Sections

- Standard Drawings (714)
  - Concrete
    - Round
    - Arch
    - Elliptical
    - Traversable
  - Steel
    - Round
    - Arch
    - Traversable
  - Aluminum
    - Round
    - Arch
FLARED END SECTION

REINFORCED CONCRETE PIPE CULVERT AND END SECTIONS

END SECTION

TERMINAL DIMENSIONS

<table>
<thead>
<tr>
<th>DIA</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>X</th>
<th>Y</th>
<th>Z</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
</tr>
<tr>
<td>12</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
</tr>
<tr>
<td>13</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
<td>1.0</td>
</tr>
</tbody>
</table>

REINFORCING STEEL

<table>
<thead>
<tr>
<th>CLASS</th>
<th>ALUMINUM</th>
<th>CLASS</th>
<th>STEEL</th>
<th>CLASS</th>
<th>STEEL</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

NOTES

1. All reinforcing steel shall be full yield strength steel.
2. All reinforcing steel shall be full yield strength steel.
3. All reinforcing steel shall be full yield strength steel.
4. All reinforcing steel shall be full yield strength steel.
5. All reinforcing steel shall be full yield strength steel.
6. All reinforcing steel shall be full yield strength steel.
7. All reinforcing steel shall be full yield strength steel.

CONCRETE PIPE CONFORMS TO STRENGTH REQUIREMENTS OF REINFORCED CONCRETE PIPE DEPARTMENT OF TRANSPORTATION.

CONCRETE PIPE PLUGS CONFORM TO STRENGTH REQUIREMENTS OF REINFORCED CONCRETE PIPE DEPARTMENT OF TRANSPORTATION.

CONCRETE PIPE CONFORMS TO STRENGTH REQUIREMENTS OF REINFORCED CONCRETE PIPE DEPARTMENT OF TRANSPORTATION.

CONCRETE PIPE PLUGS CONFORM TO STRENGTH REQUIREMENTS OF REINFORCED CONCRETE PIPE DEPARTMENT OF TRANSPORTATION.

CONCRETE PIPE CONFORMS TO STRENGTH REQUIREMENTS OF REINFORCED CONCRETE PIPE DEPARTMENT OF TRANSPORTATION.

CONCRETE PIPE PLUGS CONFORM TO STRENGTH REQUIREMENTS OF REINFORCED CONCRETE PIPE DEPARTMENT OF TRANSPORTATION.

CONCRETE PIPE CONFORMS TO STRENGTH REQUIREMENTS OF REINFORCED CONCRETE PIPE DEPARTMENT OF TRANSPORTATION.

CONCRETE PIPE PLUGS CONFORM TO STRENGTH REQUIREMENTS OF REINFORCED CONCRETE PIPE DEPARTMENT OF TRANSPORTATION.

CONCRETE PIPE CONFORMS TO STRENGTH REQUIREMENTS OF REINFORCED CONCRETE PIPE DEPARTMENT OF TRANSPORTATION.

CONCRETE PIPE PLUGS CONFORM TO STRENGTH REQUIREMENTS OF REINFORCED CONCRETE PIPE DEPARTMENT OF TRANSPORTATION.

CONCRETE PIPE CONFORMS TO STRENGTH REQUIREMENTS OF REINFORCED CONCRETE PIPE DEPARTMENT OF TRANSPORTATION.

CONCRETE PIPE PLUGS CONFORM TO STRENGTH REQUIREMENTS OF REINFORCED CONCRETE PIPE DEPARTMENT OF TRANSPORTATION.

CONCRETE PIPE CONFORMS TO STRENGTH REQUIREMENTS OF REINFORCED CONCRETE PIPE DEPARTMENT OF TRANSPORTATION.

CONCRETE PIPE PLUGS CONFORM TO STRENGTH REQUIREMENTS OF REINFORCED CONCRETE PIPE DEPARTMENT OF TRANSPORTATION.

CONCRETE PIPE CONFORMS TO STRENGTH REQUIREMENTS OF REINFORCED CONCRETE PIPE DEPARTMENT OF TRANSPORTATION.

CONCRETE PIPE PLUGS CONFORM TO STRENGTH REQUIREMENTS OF REINFORCED CONCRETE PIPE DEPARTMENT OF TRANSPORTATION.

CONCRETE PIPE CONFORMS TO STRENGTH REQUIREMENTS OF REINFORCED CONCRETE PIPE DEPARTMENT OF TRANSPORTATION.

CONCRETE PIPE PLUGS CONFORM TO STRENGTH REQUIREMENTS OF REINFORCED CONCRETE PIPE DEPARTMENT OF TRANSPORTATION.

CONCRETE PIPE CONFORMS TO STRENGTH REQUIREMENTS OF REINFORCED CONCRETE PIPE DEPARTMENT OF TRANSPORTATION.

CONCRETE PIPE PLUGS CONFORM TO STRENGTH REQUIREMENTS OF REINFORCED CONCRETE PIPE DEPARTMENT OF TRANSPORTATION.

CONCRETE PIPE CONFORMS TO STRENGTH REQUIREMENTS OF REINFORCED CONCRETE PIPE DEPARTMENT OF TRANSPORTATION.
Traversable End Section

- Steeper slopes
- Culvert does not extend past clear zone
- 36in
Common Column Headings

- Begin Station/Location and Offset
- End Station/Location and Offset
- Length/Pipe Conduit Pay Size
- Diameter
- Allowable Material
- Min Thickness
- Existing Conditions
- End Sections
- Backfill
- Geotextile Fabric
Geotextile Fabric

- **Types**
  - **Woven**
    - Strong, does not stretch
    - Made by weaving synthetic fabrics together
  - **Unwoven**
    - Often used as in drainage as a conduit

- **Processes**
  - Needle punching: barbed needles are pushed through one or more fiber mats which entangles the fibers.
  - Heat Bonding: Fibers with different melting points are used
  - Resin Bonding: Fibers are coated with resin to bond the fibers together
Geotextile Fabric

- Uses
  - Filtration
  - Drainage
  - Sediment Control
  - Separation
  - Erosion Control
  - Moisture Barriers
  - Reinforcements

www.geotextilefabric.net
## Pipe List

<table>
<thead>
<tr>
<th>Begin Station / Location</th>
<th>Begin Offset</th>
<th>End Station / Location</th>
<th>End Offset</th>
<th>Length</th>
<th>Pipe conduit approach Pay Size</th>
<th>Pipe conduit storm drain Pay Size</th>
<th>Allowable Material</th>
<th>Required Diameter</th>
<th>Minimum Thickness</th>
<th>R1 Fabric (Pay Item)</th>
<th>(A) End Sections</th>
<th>Applicable Backfill Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>D-714-27</td>
</tr>
<tr>
<td>3A</td>
<td>3</td>
<td>46' Lt</td>
<td>60</td>
<td>40</td>
<td></td>
<td></td>
<td>Reinforced Concrete Pipe - Class II (barrel length = 86 LF)</td>
<td>18</td>
<td>3</td>
<td>Y</td>
<td>Y</td>
<td>D-714-26</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Zinc Coated Steel (2-2/3&quot; x 1/2&quot; Ribs)</td>
<td>18</td>
<td>3.168</td>
<td>Y</td>
<td>Y</td>
<td>D-714-25</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Aluminum Coated Steel (Type 2)</td>
<td>18</td>
<td>3.138</td>
<td>Y</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Polymetric Coated Steel (over zinc or aluminum coated steel)</td>
<td>18</td>
<td>3.004</td>
<td>Y</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>1296+30</td>
<td>46' Lt</td>
<td>1296+30</td>
<td>46'Rt</td>
<td>60</td>
<td></td>
<td></td>
<td>Zinc Coated Steel (3/4&quot; x 3/4&quot; @ 7-1/2&quot; Ribs)</td>
<td>24</td>
<td>3.168</td>
<td>Y</td>
<td>Y</td>
<td>D-714-26</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Aluminum Coated Steel (Type 2)</td>
<td>30</td>
<td>3.138</td>
<td>Y</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Aluminum Alloy</td>
<td>30</td>
<td>0.060</td>
<td>Y</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Polymetric Coated Steel (over zinc or aluminum coated steel)</td>
<td>24</td>
<td>0.064</td>
<td>Y</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>1304+25</td>
<td>46' Lt</td>
<td>1304+25</td>
<td>46'Rt</td>
<td>67</td>
<td></td>
<td></td>
<td>Zinc Coated Steel (2-2/3&quot; x 1/2&quot; Ribs)</td>
<td>30</td>
<td>0.064</td>
<td>Y</td>
<td>Y</td>
<td>D-714-25</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Aluminum Coated Steel (Type 2)</td>
<td>30</td>
<td>0.064</td>
<td>Y</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Polymetric Coated Steel (over zinc or aluminum coated steel)</td>
<td>30</td>
<td>0.064</td>
<td>Y</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>1345+30</td>
<td>67'Rt</td>
<td>1346+04</td>
<td>67'Rt</td>
<td>44</td>
<td></td>
<td></td>
<td>Zinc Coated Steel (2-2/3&quot; x 1/2&quot; Ribs)</td>
<td>18</td>
<td>0.064</td>
<td>Y</td>
<td>Y</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Aluminum Coated Steel (Type 2)</td>
<td>18</td>
<td>0.064</td>
<td>Y</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>High Density Polyethylene (HDPE)</td>
<td>18</td>
<td>0.064</td>
<td>Y</td>
<td>Y</td>
<td></td>
</tr>
</tbody>
</table>

(A) Not paid for separately, to be included in the price bid for Pipe Conduit.
Plans

- **Excel to MicroStation**
  - Copy/Paste—Won’t update table if it is changed in excel
  - Edit>Insert Object>From File>Select Excel File to Insert
  - Paste Link—Axiom tool (office importer), keeps link and updates table
Resources

- www.ct.gov
- corrosion-doctors.org
- www.dot.nd.gov
- American Association of State Highway and Transportation Officials (AASHTO)
- Corrugated Steel Pipe Design Manual
  - Published by National Corrugated Steel Pipe Association 2008
- www.geotextilefabric.net